Peter Faulks – Excel Introduction

Y7 Excel Binary Code Table

These pages are designed to show you how to use software packages; various software updates may have taken place so some pages will not apply to versions other than those listed here. In some cases data files may be required.
Items highlighted in yellow are tasks for you to complete Items in Blue italics are help tips
[bookmark: _Toc100923036][bookmark: _Toc100923032]Open Excel then work through this worksheet
Features of a worksheet 

The Spreadsheet is made up of worksheets, with rows and columns of cells in each worksheet. Rows go down column go across cells contain text numbers dates or times and will also include calculations. 
[image: Screen shot 2019-02-07 at 11]

Task 1
We are going to create a spreadsheet that will calculate binary code

Items in Yellow are for you to complete individually


1. Open Excel

Save the sheet as Your name Binary.xls or .xlsx
In your first worksheet 
2. In Cell A1 type First Name (this is your first name) 
3. In Cell B1 type Last Name (your last name)

[image: Screen Shot 2022-09-29 at 10]

4. In the following row in Cell C1 Type 8 Bit Code

[image: Screen Shot 2022-09-29 at 10]


5. Next  move or Tab to the next columns D1, E1, F1 etc. and type and complete the row as shown
 
The numbers are D1 128, E1 64, etc. as shown

[image: Screen Shot 2022-09-29 at 10]

6. Save your spreadsheet


7. Highlight the row by dragging the mouse over all cells and center the numbers on our worksheet 

[image: Screen Shot 2022-09-29 at 10]

Your window might look like this
[image: 005 Excel Binary]

8. With the cells highlighted, center all the numbers

Cell A2 Type Binary No.  
Cell C2 Type Enter 1 or 0

Underneath each Binary number type a zero 0

[image: Screen Shot 2022-09-29 at 10]
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9. Click on Cell D3 
This is the calculation

=if Cell D2 = 1, then copy Cell D1, if not the leave it as a zero
 Here is the actual calculation
=IF(D2=1,D1,0)

[image: Screen Shot 2022-09-29 at 10]

If D2 = 1                           Then Put D1 into this cell, if not then it is a 0

then tick box green tick [image: Screen Shot 2022-09-29 at 10]

This would be the answer

[image: Screen Shot 2022-09-29 at 10]

Because Cell D2 has a 1 then Cell D3 Shows the binary code number (128)

We could be clever here and copy this formula across all the table 

10. click on cell D3 and a little square will appear in the bottom right hand corner, drag this square across the row to Cell K3 and the formula will work in all the cells.
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I have put a 1 in Cell G2 and you can see that the number 16 is shown below.

[image: Screen Shot 2022-09-29 at 10]

Now given a number to find Say you are asked to find the following binary codes for  Slide 6 in week 1 questions

Numbers (for this one, convert the following numbers from decimal to 8-bit binary: 
0, 1, 2, 3, 4, 5, 6, 7, 8, 9, 10, 12, 15, 16, 20, 23, 24, 25, 32, 40, 45, 50 – 

hint: stick them in a table to make it easier) 

11. Clear all the numbers in Row 2 D2 to K2

we can type under any binary number to find the Binary Code for instance you are asked for the binary code for 25
So you would enter a 1 under the next lowest number to 25 which would be 16 (you need to add up to 25) so 16 + 8 would give you 24 so put a 1 under 8 and we need another 1 to make 25 so we would have 16+8+1 = 25

Shown here would be our binary code

[image: Screen Shot 2022-09-29 at 10]

12. We can then write our binary code as :  00011001 = 25


13. Save your work

You can now work converting numbers to binary

14. Complete the table as shown then start calculating binary code.

15. Here is a table you need to fill in for question 6 for Task 1

[image: Peter Faulks's iMac:Users:peterfaulks:Desktop:Screen Shot 2022-09-29 at 11.19.08 AM.png]

ADVANCED

If you are feeling confident you could add some colour to the top numbers, or any row, highlight them and click on fill and pick a colour. You choose the colours.
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or any row

[image: Screen Shot 2022-09-29 at 10]


[bookmark: _GoBack]We can also add the cell lines so we can see the table clearer.  Select all cells then select cell Borders 


[image: 006 Excel Binary]

Here is the spreadsheet so far

Bring all back to zero in row 2

[image: Screen Shot 2022-09-29 at 11]

Find another number
[image: Screen Shot 2022-09-29 at 11]

What is the Binary code for 45 = 


End of lesson more information below if you are interested
Understand data types and data entry
[bookmark: _Toc100923033]Data types
Most spreadsheets can handle the following types of data:
· numbers
· dates
· times
· text.
Numbers 
Numbers can have different formats. On a computer, whole numbers are represented in a different way to decimals. In spreadsheets we often work with even more specialised numbers like time of day and money amounts. Spreadsheets are specifically designed to handle each of these different types of numbers appropriately.
Most spreadsheets have a default representation for different types of numbers. So, for example, if you enter 4.55 in a spreadsheet you will probably find that your spreadsheet treats this as a number with many digits of precision: 4.50000000000000. This may not be what you want if the value to represent is in dollars and cents.
[image: Screen shot 2019-02-07 at 10]
The screen shot below shows the main features of an open worksheet:


[image: Screen shot 2019-02-07 at 11]


Figure 1: Main features of an open worksheet in Microsoft Excel
Dates
Dates contain numbers and we commonly use different ways of representing them. For example:
· 5/9/2022
· 5-9-2022 
· 5-Sep-2022 
· September 5 2022
While we have little trouble with these variations, a computer program would. So most spreadsheet programs require you to use just a few basic alternatives. To add to the difficulty, USA dates are different to Australian date formats. In Australia 5/9/2004 means September 5th, while in the USA it means 9th of May.
[image: Screen shot 2019-02-07 at 10]Times
Times are also tricky. We can be using a 12-hour clock or a 24-hour clock. The spreadsheet needs to know which is being used, otherwise calculations based on time could be incorrect.
[image: Screen shot 2019-02-07 at 10]Text
Text is more straightforward and most spreadsheets will treat any combination of characters with numeric and non-numeric characters as text. For example, a telephone number like: 9123 456 is likely to be treated as text rather than a number because it contains a space.
[bookmark: _Toc100923034]Data entry
There are a number of methods of data entry. When creating a spreadsheet document from scratch you can start with a blank document and create your own spreadsheet from the keyboard. Alternatively, you can import data from an existing spreadsheet.
Investigate your spreadsheet package to get familiar with:
1	required data formats for: numbers, dates, times and text on your spreadsheet package
2	creating a spreadsheet from scratch and importing data from a sample spreadsheet.
For more information and tutorials on how to do this, there are documents you can download in the Research section of this Learning pack. You should also use the built-in Help resources in your software to guide you through the steps in detail.
[bookmark: _Toc100923035]Understand the main features of a spreadsheet
Here are the main features that a spreadsheet package may contain, in terms of the way in which the spreadsheet file is set up. You’ll need to investigate if your package works a little differently to the examples below for the Microsoft Excel spreadsheet package.
Worksheets
A worksheet is a single sheet in the spreadsheet used to list and analyse data. You can enter and edit data on several worksheets simultaneously and perform calculations based on data from multiple worksheets.
Workbook
In Microsoft Excel, a workbook is the file in which you work and store your data. Each workbook can contain many worksheets and you can organise various kinds of related information in a single file.
Sheet tabs
The names of the sheets appear on tabs at the bottom of a workbook window. To move from sheet to sheet, click the sheet tabs.
[bookmark: _Toc86556263][bookmark: _Toc100739060][bookmark: _Toc100923037]Format text and numbers
[bookmark: _Toc100923038]Text
Spreadsheets usually allow you to take control over how your data appears in the spreadsheet. This includes options for:
· font type
· font size
· font styles like bold, italic, underline.
Most spreadsheet packages provide a wide range of formatting options. 
[image: Screen shot 2019-02-07 at 11]
[bookmark: _Toc100923039]Numbers
Number formatting enables you to specify how basic characteristics such as the number of decimal places and highlighting of negative numbers are displayed.
For more information and tutorials on how to format characters, there are documents you can download in the Research section of this Learning pack. You should also use the built-in Help resources in your software to guide you through the steps in detail.

[bookmark: _Toc86556268][bookmark: _Toc100739065][bookmark: _Toc100923040]Use simple formula
Formulas calculate values in a specific order. Typically, you might want to add together all the values in a column or row of your spreadsheet. This is usually done by entering a formula that enables the add (+) operation to be applied to a range of cells. Because the cells are each identified by a unique name (row number and column letter) it is easy to specify in the formula which cells are to have the calculation applied to them.
The description below is based on the spreadsheet package Microsoft Excel, but most spreadsheets use the same system for representing formulas and ranges of cells.
In most spreadsheet packages a formula always begins with an equal sign: =. The equal sign tells the spreadsheet program that the following characters make up a formula. Following the equal sign are the elements to be calculated (the cells containing the numbers for the calculation, or operands), which are separated by calculation operators (+, -, * multiply or / divide). The spreadsheet program calculates the formula from left to right, according to a specific order for each operator in the formula. For example: type = in Cell E2 
=B2+C2-D2
[image: Screen shot 2019-02-07 at 11]
will calculate the contents of cell B2 added to the contents of cell C2 from which the contents of cell D2 will be subtracted.
[image: Screen shot 2019-02-07 at 11]
You can change the order of operations by using parentheses (round brackets). After the formula is typed into the cell, the calculation executes immediately, the numeric value of the answer is displayed in the cell, and the formula itself is visible in the formula bar.
In the example below, the parentheses around the first part of the formula force the spreadsheet program to calculate B4+B5 first and then divide the result C3:
E2 type =(B4+B5)/C3 (click on cells)
[image: Screen shot 2019-02-07 at 11]

[image: Screen shot 2019-02-07 at 11][image: Screen shot 2019-02-07 at 11]
Whenever a cell that the formula refers to changes, the dependent cell also changes, by default. For example, if a value in any of the following cells changes, the result of the formula =B2+C2+D2 also changes.
Make sure you know how your spreadsheet package represents formulas and cell ranges and how it may be different to examples given above.

Practice the above changing the numbers

[bookmark: _Toc100923041]Use operators
Operators are actions that are applied to a value or values. Operators are usually represented by a symbol. For example, + (plus, or add) is an operator that is usually applied to two values: 3+4 produces a new value 7. You are probably familiar with the basic arithmetic operators.[image: Screen shot 2019-02-07 at 11]

Spreadsheets use the usual arithmetic operators but introduce several of their own to represent things like cell ranges. For example: 
D5:D20
represents the cells from D5 to D20, as formulas can also refer to names of cells or to ranges (groups) of cells.
Other operators you’ll find within a spreadsheet are represented as:

	Operator
	Description

	%
	percent

	^
	Exponentiation (raised to the power of)

	*
	multiplication

	/
	division

	+
	addition

	-
	subtraction



[bookmark: _Toc100923042]The order of operations
You may not be so familiar with the idea that when several operators appear in the same expression, for example:
4 + 3*5
they have a precedence. This means that the operators with highest precedence are performed first. In the example above, multiply (*) has a higher precedence that plus (+). So the value of 4+3*5 is 19 and not 35.
An easy rule to remember when evaluating arithmetic expressions, that is, how the order in which a calculation is performed, is BODMAS:
Brackets		()
Of			of
Division		/
Multiplication		*
Addition		+
Subtraction		-
If you are in any doubt about how a formula you write will be calculated, put brackets around the parts you want performed first.
If you are not using Microsoft Excel, check the order in which operations are performed (operator precedence) in your spreadsheet package to check.

[bookmark: _Toc86556275][bookmark: _Toc100739067][bookmark: _Toc100923043][bookmark: _Toc86556273][bookmark: _Toc86556269]Use simple functions
Functions are predefined formulas that perform calculations by using specific values called arguments. For example, the SUM function adds values or ranges of cells.
Arguments can include numbers, text or cell references. The argument you designate must produce a valid value for that argument. 
The structure of a function is as follows:
1	begins with the function name
2	followed by an opening parenthesis
3	then the arguments for the function separated by commas
4	then a closing parenthesis. 
For example: 
[image: Screen shot 2019-02-07 at 11]
Figure 2: The structure of a function 
If the function starts a formula, type an equal sign (=) before the function name. As you create a formula that contains a function, the Formula Palette will assist you.
Most spreadsheets will have the following useful functions:
· SUM – adds the values of all of the cells in the range
· MAX – finds the largest number in the range of cells
· MIN – finds the smallest number in the range of cells
· COUNT – counts the total number of cells in the range
· AVERAGE – adds the values of each cell in the range and the divides by the number of cells in the range.
[bookmark: _Toc100739068][bookmark: _Toc100923044]SUM
The most frequently used function is the SUM function, which is used to add the numbers in a range of cells. The syntax (the specific way of expressing a SUM) is:
SUM(number1,number2,etc)
number1,number2,etc can include 1 to 30 numbers for which you want the total value or sum. The items in the parentheses ( ) are arguments.
Numbers, logical values, and text representations of numbers that you type directly into the list of arguments are counted. See the first and second examples below.
Arguments that are error values, or text that cannot be translated into numbers, cause errors.
Examples
SUM(3,2) equals 5
If the range of cells A2:E2 (cell A2 through cell E2) contains 5, 15, 30, 40, and 50:
SUM(A2:C2) equals 50 
and
SUM(B2:E2,15) equals 150.
[bookmark: _Toc100739069][bookmark: _Toc100923045]MAX
This function returns the largest value (or number) in a set of values. The syntax used to express this is:
MAX(number1,number2,etc)
number1,number2,etc can include 1 to 30 arguments for which you want to find the maximum (highest) value. 

Example
If the range of cells A1:A5 (cell A1 through cell A5) contains the numbers 10, 7, 9, 27, and 2, then:
MAX(A1:A5) equals 27.
[bookmark: _Toc86556270][bookmark: _Toc100739070][bookmark: _Toc100923046]MIN
MIN returns the smallest value in a set of values.
Example 
If A1:A5 contains the numbers 10, 7, 9, 27, and 2, then:
MIN(A1:A5) equals 2.
[bookmark: _Toc86556271][bookmark: _Toc100739071][bookmark: _Toc100923047]COUNT
This function counts the number of cells that contain numbers within the list of arguments. Use COUNT to get the number of entries in a number field in a range of numbers. The syntax for COUNT is:
COUNT(value1,value2,etc)
value1,value2,etc are 1 to 30 arguments that can contain or refer to a variety of different types of data, but only numbers are counted. 
Arguments that are numbers, dates, or text representations of numbers are counted; arguments that are error values or text that cannot be translated into numbers are ignored.
Example
	
	For this list:
COUNT(A1:A7) equals 3
COUNT(A4:A7) equals 2.



[bookmark: _Toc86556272][bookmark: _Toc100739072][bookmark: _Toc100923048]AVERAGE
AVERAGE returns the average of the group of numbers. The syntax used is:
AVERAGE(number1,number2,etc)
number1,number2,etc are 1 to 30 arguments for which you want the average. The arguments must be numbers or text that can be translated into numbers.
Example
If the range of cells A1:A5 contains the numbers 10, 7, 9, 27, and 2, then:
AVERAGE(A1:A5) equals 11.
[bookmark: _Toc86556278][bookmark: _Toc100739075][bookmark: _Toc100923049][bookmark: _Toc86556276]Use absolute reference
Calling cells by just their column and row labels (such as A1) is called relative referencing. 
For example, if a simple addition formula in cell C1 such as =(A1+B1) is copied to cell C2, the formula would change to =(A2+B2) to reflect the new row.
To prevent this change, cells must be called by absolute referencing. This is accomplished by placing dollar signs ($) within the cell addresses in the formula. 
Continuing the previous example, the formula in cell C1 would read =($A$1+$B$1) if the value of cell C2 should be the sum of cells A1 and B1. Both the column and row of both cells are absolute and will not change when copied.
Mixed referencing can also be used where only the row or column is fixed. For example, in the formula =(A$1+$B2) the row of cell A1 is fixed and the column of cell B2 is fixed.
You’ll need to investigate relative versus absolute referencing on your spreadsheet package. Use the example given above to work with a simple spreadsheet and see how the values change.

[bookmark: _Toc100739073][bookmark: _Toc100923050]Create charts
Charts, or graphs, are visually appealing and make it easy for you to see comparisons, patterns, and trends in data. For instance, rather than having to analyse several columns of worksheet numbers, you can see at a glance whether sales are falling or rising over quarterly periods, or how the actual sales compare to the projected sales.
You can create a chart on its own sheet or as an embedded object on a worksheet. You can also publish a chart on a Web page. 
To create a chart, you must first enter the data for the chart on the worksheet. In Microsoft Excel you then select that data and use the Chart Wizard to step through the process of choosing the chart type and the various chart options.
A chart can be linked to the worksheet data it’s created from, and is updated automatically when you change the worksheet data.
The screen shot shown below, is an example of a chart embedded in a worksheet.
[image: Screen shot 2019-02-07 at 11]
Figure 3: An example of a chart embedded in a worksheet
Before reading on, investigate the options for creating charts on your spreadsheet package.
[bookmark: _Toc86556277][bookmark: _Toc100739074][bookmark: _Toc100923051]Design a spreadsheet
Spreadsheet software is powerful and flexible but without care and planning it is easy to produce results that are difficult to read or modify. 
[bookmark: _Toc100923052]Design guidelines
Here are some basic elements that your spreadsheets should include:
1	Easy to read. Make your spreadsheet easy to understand by adding comments and using formatting, colours and borders. Choose fonts and backgrounds and colours for good contrast and easy reading. Consider how the sheet will look in print as well as on screen.
2	Logical positioning. Position data logically, both for reading and for entering data.
3	Description. Create helpful labels and titles that make the purpose and function of the sheet clear.
4	Important parts. Position and format the key values, like totals, to make them stand out.
5	Changes. Arrange the sheet so that adding new data will not break formulas. Surround data groups that may have additions later by blank cells and write formulas that include the blanks. Or use ‘absolute references’ to cells that will not be moved if data is added.
6	Original data. Use copies or links to original data for actions that may be hard to undo, such as sorting and subtotals. This preserves the original data for other uses later.
7 Future modifications. Think ahead to the future uses of your sheet. Anticipate the needs of other people who may use your sheet without knowing all that you know about it.
Remember, the more complex your spreadsheet is, the more planning will be needed before you create it. Some planning tips are:
· before you create the spreadsheet on the computer, write down the data and any functions you need
· reserve the first row (horizontal) for a title, the second row for row headings, and the first column (vertical) for column headings.
Finally, remember to save your work often.
[bookmark: _Toc86556279][bookmark: _Toc100739076][bookmark: _Toc100923053]Use built-in Help resources
Getting help on features in your spreadsheet is one of the most import skills you need to have. The ability to get information quickly on a particular feature will allow you to work efficiently to create spreadsheets.
Spreadsheet packages will vary quite a bit in how much help they provide. The most basic provide only a tutorial that can be used in a browser. The more advanced spreadsheets often provide help in a variety of ways:
· mini tutorials on specific items
· search engines that allow you to search for help on a word or phrase that you type in
· context-sensitive help which allows you to retrieve information about a feature that your cursor is currently pointing to.
You should investigate how to use the Help resources in your spreadsheet package.
[bookmark: _Toc86556280][bookmark: _Toc100739077][bookmark: _Toc100923054]Summary
You can use a spreadsheet to organise and view a lot of information — including numbers, dates, times and text — at a glance. Use the text and number formatting features, and charts, to display the data so that it is easy-to-read and understand.
It is important to understand the main features of a worksheet, such as cell referencing, in order to enter data or import data into a sheet.
Then you can use a spreadsheet to perform calculations with the data contained in one or more worksheets. Here, we looked at simple formulas you can write in order to add, subtract, multiply and divide the values shown in particular cells. To write a formula, you use operators (symbols) like +, -, * and / as well as operators unique to a spreadsheet, like : which you use to refer to a range of cells.
You can also practise writing and using functions – predefined formulas that give you a value of numbers in a particular range of cells, such as the total (SUM), largest number (MAX), smallest number (MIN), a cell count (COUNT) or average amount (AVERAGE).
You have been encouraged to find out the detailed steps to practise using these features in your spreadsheet package by:
· downloading the tutorials in the Research section of this Learning pack
· using built-in Help resources.

[bookmark: _Toc86556281][bookmark: _Toc100739078][bookmark: _Toc100923055]Check your progress
Now you should try and do the Practice activities in this topic. If you’ve already tried them, have another go and see if you can improve your responses.
When you feel ready, try the ‘Check your understanding’ activity in the Preview section of this topic. This will help you decide if you’re ready for assessment.


100  Excel 2007- Create your first workbook1
Open Excel
After the first 26 column headings (A through Z), the next 26 column headings are AA through AZ. The column headings continue through column XFD, for a total of 16,384 columns.
Rows 			and 				columns
[image: ]
The first cell is A1 
When you select any cell, it becomes the active cell. When a cell is active, it is outlined in black, and the headings for the column and the row in which the cell is located are highlighted.
For example, if you select a cell in column C on row 5, the headings on column C and row 5 are highlighted, and the cell is outlined. That cell is known as cell C5, which is the cell reference.
The outlined cell and the highlighted column and row headings make it easier for you to see that cell C5 is the active cell. Also, the cell reference of the active cell appears in the Name Box in the upper-left corner of the worksheet. By looking in the Name Box, you can see the cell reference of the active cell.[image: ]



All of these indicators are not too important when you're right at the very top of the worksheet in the very first few cells. But when you work further and further down or across the worksheet, they can really help you out. Keep in mind that there are thousands of cells to work in on each worksheet. You could get lost without the cell reference to tell you where you are. 
For example, it's important to know the cell reference if you need to tell someone where specific data is located or must be entered in a worksheet.
In the practice you'll see how to use the Name Box to go straight to cells located anywhere on the worksheet.
Open Excel
100 Excel 2007- Create your first workbook1.xlsx
[image: ]

WE will work through creating a budget.
Exercise 1: Rename a worksheet tab
In a new workbook, the worksheet tabs at the bottom of the workbook are called Sheet1, Sheet2, and Sheet3. In this exercise you'll give a new name to one of the worksheet tabs. 
1. Right-click the Sheet1 tab (Mac double Click) at the bottom of the window, and then click Rename. 
The Sheet1 name is selected.
[image: Sheet tab name]
2. Type the new name: Budget, and then press ENTER. 
Tip    You can also rename the selected worksheet tab by clicking the Home tab at the top of the Ribbon (the first tab on the left). In the Cells group (the group name is at the bottom of the Ribbon), click the arrow on Format, and click Rename Sheet. Then, on the worksheet tab at the bottom, type the new name.
Exercise 2: Move from one worksheet to another
In this exercise you'll learn different ways to move from one worksheet to another.
Why would you need to use more than one sheet, and need to move from one sheet to another? Basically, to keep things apart so they are easier to see. You might have budgets for different months on different sheets, or grades for different classes, or repair records for different cars. It can be easier to move between sheets than to scroll up and down a lot. 
1. Click the Sheet2 tab. That moves you from the Budget worksheet to the Sheet2 worksheet. In a blank worksheet it's hard to tell that you've really changed sheets, since everything looks the same. 
2. That's why we put "Worksheet 2" in cell A1 of this one. 
[image: ]
If you don't see "Worksheet 2," press CTRL+HOME to take the insertion point to cell A1. 
3. Now use a keyboard shortcut to move to the Sheet3 tab. Press CTRL+PAGE DOWN. 
Now you're in the Sheet3 worksheet (it says "Worksheet 3" at the top).
4. Try the keyboard shortcut to move to the previous worksheet. Press CTRL+PAGE UP. There's "Worksheet 2" in cell A1. 
Exercise 3: Add color to worksheet tabs
You can add color to worksheet tabs to make them easier to tell apart. 
1. Right-click the Budget tab, point to Tab Color, and select the color you want. 
2. Now the tab has a band of the color you chose. Click the Sheet2 tab. Notice that now the Budget tab is fully colored. A color band means that the worksheet is on top, and full color means that it is not the one on top.
Tip    You can also start to add color to the worksheet tab by clicking the Home tab at the top of the Ribbon (the first tab on the left). In the Cells group, click the arrow on Format, and then click Tab Color. 
Exercise 4: Add and delete worksheets
A workbook comes with three worksheets, but you can add or delete worksheets as you wish. 
Add a worksheet
On the Ribbon on the Home tab, in the Cells group, click the arrow on Insert, and then click Insert Sheet. A new worksheet is inserted. You see the Budget tab and three other tabs. A new sheet is usually inserted in front of the selected sheet.
Tip    You can also insert a worksheet by clicking the Insert Worksheet button [image: Insert Worksheet button](to the right of the worksheet tabs). 
Delete a worksheet
Click the Sheet3 tab at the bottom of the worksheet. In the Cells group, click the arrow on Delete, and then click Delete Sheet. Or right-click the Sheet3 tab, and then click Delete.
You'll see a message that data may exist on the worksheet. Because the text "Worksheet 3" is on the worksheet, Excel wants to know if you're really sure about deleting the sheet. You're sure, so click Delete. The Sheet3 worksheet is deleted. 
Exercise 5: Review column headings and use the Name Box
In this exercise you'll take a look at column headings and see how to use the Name Box to navigate in the worksheet. 
1. Click the Budget tab. 
2. Place the insertion point in the Name Box in the upper-left corner of the window. It's right above cell A1. It says "A1" in the box. 
[image: Name Box]
3. Type AA1 in the Name Box, and then press ENTER. 
Now cell AA1 is the active cell. It's outlined in black, and the column heading for column AA is highlighted. Column AA is the 27th column. After the 26 letters of the alphabet have been used, the column headings start over again as pairs, with AA followed by AB and so on. 
The heading for row 1 is highlighted as well, since the active cell is in the first row. 
4. Now try another way to activate a specific cell. Press F5 to open the Go To dialog box. 
In the Reference box at the bottom of the dialog box, type XFD1048576, and then press ENTER.
That's all, folks. You've reached the very last cell in the worksheet, cell 1,048,576 in column XFD. 
5. To go back to cell A1, press CTRL+HOME. 
Exercise 6: Save the workbook
When you save files, it can be unclear where they end up. If you've ever wondered, try this exercise. If you're at ease about that, you can skip this exercise and go back to the lesson.
1. Click the Microsoft Office Button [image: Button image]on the upper left of the Ribbon. Then click Save or Save As. The Save As dialog box opens. Near the top of the dialog box, in the Save in box, click the arrow on the right to see a list of folders that you can store the workbook in. The My Documents folder is a good place to save files such as documents, worksheets, or databases. Select it. 
Normally, you don't have to select this folder. When you open the Save As dialog box after starting a Microsoft Office program, you'll see My Documents in the Save in box. 
2. Notice that in the Save as type box near the bottom of the Save As dialog box, Excel Workbook is listed. Excel 2007 workbooks have an .xlsx file extension. Depending on your computer settings, you may or may not see the .xlsx file extension at the end in the Save as type box. 
In the File name box, you can accept the name that's entered for you, or you can enter another name. 
3. Click Save. 
4. Close the workbook you just saved. Click the Microsoft Office Button [image: Button image], and then click Close. 
5. Now find and open the workbook. Click the Microsoft Office Button [image: Button image], and then click Open. 
6. In the Look in box near the top of the Open dialog box, My Documents should be listed. If not, click the arrow and select that folder. 
7. Select the workbook you just saved and click Open. 
Tip    If you don't see the file, you may not have put it where you think you put it. To see where you put it, open a new file, click Save As after you click the Microsoft Office Button [image: Button image], and see what folder is in the Save in box. This works only if you haven't saved anywhere else in the meantime. 
You can enter two basic kinds of data into worksheet cells: numbers and text. 
You can use Excel to create budgets, to work with taxes, or to record student grades. 
You can use Excel to list the products you sell or to record student attendance. 
You can even use Excel to track how much you exercise every day, and your weight loss, or how much your house remodel is costing you. The possibilities really are endless.
Now let's dive into data entry. Open Excel worksheet 2
Get to know Excel 2007- Create your first workbook2
Label the sheet as follows
Worksheet with column and row titles.2
[image: ]


	Mortgage

	600.00

	Telephone
	45.25

	Utilities
	67.27

	Charge Cards
	200.00

	Electricity
	100.00

	Auto Insurance
	150.00

	Cable TV
	40.75

	Groceries
	40.00

	Pets
	25.00

	Meals Out
	50.00

	Entertainment
	80.00

	Auto Loan
	200.00

	Water
	15.00



The column titles are the months of the year. 
The row titles are expenses.
	When you enter data, it's a good idea to start by entering titles at the top of each column so that anyone who shares your worksheet can understand what the data means (and so that you can understand it yourself, later on).

[image: ]If you cannot see all of the text in the expenses column then double click between A cell and B cell
You can also just drag the Colum to suit the width required

AutoFill
AutoFill    Enter the months of the year, the days of the week, multiples of 2 or 3, or other data in a series. You type one or more entries, and then extend the series.
In the picture, the column titles are the months of the year, across the top of the worksheet. 
We will use Autofill to expand the months- Drag the mouse through cells January and February
The click on the black square at the bottom of February cell and hold the mouse down and drag across the row to auto fill months to December.
[image: ]
[image: ]
You'll often want to enter row titles too. In the picture, the row titles down the left side are the names of expenses.


Press TAB or the Right arrow key to move the selection one cell to the right. Press ENTER or down arrow key to move the selection down one cell. 
Excel aligns text on the left side of cells, but it aligns dates and numbers on the right side of cells.

Enter the following information for July
	Mortgage
	900.00

	Telephone
	45.25

	Utilities
	67.27

	Charge Cards
	200.00

	Electricity
	100.00

	Auto Insurance
	150.00

	Cable TV
	40.75

	Groceries
	140.00

	Pets
	25.00

	Meals Out
	50.00

	Entertainment
	80.00

	Auto Loan
	200.00

	Water
	15.00



And now the rest of the year

Mortgage at 900 (Autofill through to June)
Telephone 
July 	45.40 
August 	38.45 
September to December 	45.25
Jan	47.50
Feb 	47.25 
March 	48.75 
April 	45.20 
May 	39.80
June 	45.30 
 


Utilities 
July 	65.40 
August 	58.45 
September to December 	67.25
Jan	68.90
Feb 	67.25 
March 	68.75 
April 	65.20 
May 	69.80 
June 	65.30 
Charge Cards 200 each month through to December (How would you enter these?)
Electricity =  January to March 100, April to June 120, July to September 115 and October to December 105
Auto insurance is paid quarterly in January, April, July and October
Cable TV increases to 45.25 From December
Groceries increase to 250 per month from March and to 255 per month from September, as a consequence Meals out reduce to 40 and 35 for the same months. However in December meals out increases to 80.
Auto Loan stay the same throughout the year 
Water increase to 18.50 from January.



Select all of the cells that you have entered by dragging the mouse across the data. The select currency from the Number tab and use the $ with two decimal places.

[image: ]

Select the row of months and fill them with a colour to help identify the row.

At the bottom of the column containing the first row of expenses for January Type TOTALS 


Entering Calculations [image: Picture 1]


In the cell B17 type =

We can add the expenses one by one by clicking on a cell and putting + into each calculation [image: Picture 2]

















But we can add all the calculations as a sum = SUM (Drag through selection to add)
In this case the range is all the expenses for January (B3:B15)[image: Picture 3]


We now have the total expenses for January.

We can AutoFill the sum totals cross each month. Do this now.

Excel automatically recognizes the sum for each month.

Underneath TOTALS in cell A19 type Income and the following…

Salary 	4800
Overtime 	150
Other Income	45
Sub Total Income	+++
Deductions
Tax	Sub Total *.20
Other 1	40
Other 1
Sub Total Deductions	+++

Total Income	Sub Total Income - Sub Total Deductions 

Bank Balance  	= Income - Expenses

Now you may notice that we have moved so far down we cannot see to top of our list we can Freeze either top row or first column or split the worksheet into four, however you can select the split yourself.

Move the split bar to just below the top row.
[image: ][image: ] Drag down to just below months.[image: ]
Split Bar

 




Do the same for the first column 			Splits Horizontal (Row) and Vertical (Column)
[image: ]
[image: ]












Open the spreadsheet to compare your work with the sample
100 Excel 2007- Create your first workbook2 PJF








Add formulas that show the average, maximum and minimum for each expense item, add a grand total of expenses for each expense at the end of the year.


Next lesson we will look at absolute cells, charts  and conditional formatting plus more formula calculations.

Finally we should add a header and footer
Insert a predefined header or footer
1. On the Insert tab, in the Header & Footer group, click Header or Footer. 

2. Click the header or footer design that you want. 
 NOTE   If you don't see a gallery of header or footer designs, there might be a problem with the Building Blocks template on your computer. See I don't see galleries of page numbers, headers and footers, cover pages, or equations for information about how to fix this problem.
The header or footer is inserted on every page of the document.
  NOTES  
· If necessary, you can format the text in the header or footer by selecting the text and using the formatting options on the Mini toolbar, which is a part of the Microsoft Office Fluent interface. 
· If you want to switch to a different predefined header or footer, repeat these steps, and choose a different header or footer from the gallery.

Insert a custom header or footer
1. On the Insert tab, in the Header & Footer group, click Header or Footer. 

2. Click Edit Header or Edit Footer. 
3. Type text or insert graphics and other content by using the options in the Insert group on the Design tab, under the Header & Footer Tools tab. 

 TIP   To save the header or footer that you created to the gallery of header or footer options, select the text or graphics in the header or footer, and then click Save Selection as New Header or Save Selection as New Footer.
[bookmark: 2]Make the first page header or footer different from the rest of the pages
1. On the first page of the document, double click the header or footer area. 
2. Under Header & Footer Tools, on the Design tab, in the Options group, select the Different First Page check box. 
 NOTE   If your document includes a cover page from the gallery of cover pages in Office Word 2007, the Different First Page option is already turned on. Inserting or editing a header or footer on this page does not affect the other pages in the document.
3. Create a header or footer, or make changes to the existing header or footer, on the first page.
[bookmark: 3]Use no header or footer on the first page
1. On the first page of the document, double click the header or footer area. 
2. Under Header & Footer Tools, on the Design tab, in the Options group, select the Different First Page check box. 
 NOTE   If the Different First Page check box is already checked, do not clear it. Go on to the next step.
3. In the First Page Header or First Page Footer area, delete the contents of the header or footer.
[bookmark: 4]Make the header or footer different for odd and even pages
For example, you can use the title of the document on odd-numbered pages, and the chapter title on even-numbered pages. Or, for a booklet, you can place page numbers on odd-numbered pages to be on the right side of the page and page numbers on even-numbered pages to be on the left side of the page. This way, the page numbers are always on the outside edge when the pages are printed on both sides of the paper.
Create odd and even headers or footers in a document that does not yet use headers or footers
 Homework - create a spreadsheet for your own budget.

To enter a date in column B, the Date column, you should use a slash or a hyphen to separate the parts: 7/16/2009 or 16-July-2009. Excel will recognize this as a date.
If you need to enter a time, type the numbers, a space, and then "a" or "p" — for example, 9:00 p. If you put in just the number, Excel recognizes a time and enters it as AM. 
Tip    To enter today's date, press CTRL and the semicolon (;) together. To enter the current time, press CTRL and SHIFT and the semicolon all at once. 

AutoComplete    If the first few letters you type in a cell match an entry you've already made in that column, Excel will fill in the remaining characters for you. Just press ENTER when you see them added. This works for text or for text with numbers. It does not work for numbers only, for dates, or for times.


















Excel Tricks

Find calculation results without using a formula

You can calculate sums, averages, and other values without creating a formula.

    1.If the status bar isn't visible, click View, and then click Status Bar. 
    2.Select the cells whose values you want to calculate. The calculation result displays in the center of the status bar. 
    3.To change the calculation type, click the status bar and then click a calculation type on the menu.

Create a chart in a single step

If you create a lot of charts, you will find this a huge timesaver. Excel creates a chart based on the default chart type.

       Select the data that you want to include in your chart and press the F11 key.

Add the date and time to a worksheet

Microsoft Excel provides a couple of ways to quickly add a date and time to a worksheet. You can use either a worksheet function or a keyboard shortcut.

    1.	Click the cell where you want to insert the date or time. 
    2.	Do one of the following: 
              To insert the current date, press CONTROL+SEMICOLON (;). 
              To insert the time, press CONTROL+SHIFT+COLON (:). 
              To insert a date, which is updated each time the workbook is opened or recalculated, type =TODAY(). 
              To insert the date and time, which is updated each time the workbook is opened or recacluated, type =NOW().

Clear the contents of selected cells

If you're tired of clearing (removing the contents of) cells one-by-one, you're in luck! In Excel X, you can quickly clear selected cells
by using a keyboard shortcut. This shortcut clears only the contents of the cells — it doesn't clear the cells' formatting or any
comments that have been inserted in the cells.

    1.	Select the cells that you want to clear. 
       To select nonadjacent cells, hold down the z key and click the cells you want.
    2.	Press CONTROL+B.

Prevent column and row headings from scrolling

If you work with large amounts of data, it can be easier to read and understand the data if the column and row headings are visible.
Locking, or freezing, these headings is very simple.

To lock column or row headings

    1.	Click a cell in the row below, or the column to the left of, your headings. For example, if your column headings are in row 1, click a cell in row 2. 
    2.	On the Window menu, click Freeze Panes.
       When you scroll your headings will remain visible. 

To unlock column or row headings

    1.	Click any cell on the worksheet. 
    2.	On the Window menu, click Unfreeze Panes.

Insert a blank row or column

Use this keyboard shortcut to save yourself some mouse clicks.

    1.	Do one of the following: 
              Select a cell in the row below where you want to insert a blank row. 
              Select a cell in the column to the right of where you want to insert a blank column. 
    2.	Press CONTROL+I. 
    3.	Click either Entire row or Entire column, and then click OK.

Switch between rows and columns

Have you ever received a workbook from someone and wanted the data to be listed in columns instead of rows or vice versa? You can switch, or transpose, the data between rows and columns with just a few clicks of the mouse.

    1.	Select the data that you want to transpose. 
    2.	On the Edit menu, click Copy. 
    3.	To open a new, blank workbook, click New [image: 2520]. 
    4.	Select the cell where you want paste the data. 
    5.	On the Edit menu, click Paste Special. 
    6.	Select the Transpose check box and click OK.

Customize keyboard shortcuts

If you'd rather use the keyboard than the mouse or if you want to change some of the default keyboard shortcuts, you'll appreciate
a new feature in Microsoft Excel X for Mac. In Excel X, you can add and change keyboard shortcuts for menu commands and other
features.

Assign a keyboard shortcut

    1.	On the Tools menu, click Customize. 
    2.	At the bottom of the Customize dialog box, click Keyboard. 
    3.	In the Customize Keyboard dialog box, select a category from the Categories list to see the commands and other items associated with that category. 
    4.	Click the command you want in the list to the right. 
       
Note   If there is currently a keyboard shortcut associated with the command, it is displayed in the Current keys box.
    5.	Click inside the Press new shortcut key box. 
    6.	Press the key combination you want to use for the command. 
    7.	Click Add. 
    8.	After you have finished assigning all the shortcuts you want, click OK. 
       
Note   If you change your mind now or later, you can reset the shortcuts by clicking Reset All.

 
 
 
 
 
 
 
 

 

Pages created by Peter J Faulks 2022                                                                                Page 42  of 42
http://www.peterfaulks.net/Teaching/Tutorials/excel.html
image3.png
.
PEHOH® XHh& © -6 25 F @5 & [oor @
| Layout | Tables | Charts | smartart | formuas | Data | Review |

i # tome

.@n.

paste () Clear ™

ot Aignmen:
Caliori @ody) |12 [+]|A~ A~] | |aber | 50 wrapText +[Genera
BI| U] [S[Al | Jwerge - (B

B

00 [

Faulks





image4.png
8 bit Code





image5.png
00| imoroee o e OH D
verge = [K5|r| % > |[%8 48 condiiondl Giiee  nsert Dolete romat  Themes

~ 8bitCode





image6.png
Home et Uraw Pagelayout Formuiss Dsta Revew View YV Tenme
[EIV & Calibri (Body) vz v A A v General v B
m- =K o BF
e g B I U~ G A o 5% BB mo
no: fe Number
A ® < o c G < W \ ; x
1+ [Namber _oote i E] 2 1 1 “ 2 1l

2
3




image7.png
A
1
2 |Binary No

D E F H K
8 bit Code 128 | 64 32 8 1
Enter 1orOinbluerow| 0 0 0 0 0





image8.png
Now for a calculation

We are going to as if a 1 is entered where there is a zero (0) the put the
binary number in the column below that number.

A B © ETF[GI R T[] K
1 8bit Code 28| 64 | 32 8 | 4|21
2 Binary No Enter 1 0r 01n blue row! oo lo[ofo o]0
|3 Donotenterinthisrofl 0 Yo | o ofojo]o

We are going to put our first calculation in here





image9.png
A

Binary No

G D E F

8 bit Code 128 | 64 32
Enter 1 or 0 in blue row

Do not Enter in thisrow| 0 0 0





image10.png




image11.png
C

o T
I
=

8 bit Code

Do not Enter in this row| 128





image12.png
32

0

128

w( 128





image13.png
© D[ E[F[G[HII J
le 128 | 64 | 32 | 16 | 8 | 4 | 2
or0in bluerow| 1 0 0 1 0 0 0
Enterinthisrow| 128 | 0 | 0 | 16 | 0 | 0 | 0





image14.png
Enter 1 or 0 in blue row check total

Do not Enter in this row

Enter number
above first Enter ONLY in BLUE Row above a 1 to calculate that bit




image15.png
A C D E F

1| Numbers {fo tisone, convertthe ollowing numbers rom decimal o &bitbinary
2 191,2,3,4,5,6,7,8,5,10,12,15,16,20,23,2¢,25,32,40,45,50~
3 |number  Tem

a o
s 1
6 2
7 3
s 4]
s 5|
10 o]
11 7]
12 8]
13 o]
14 10]
15 1]
16 12]
17 15]
18 16]
19 2]
20 23|
21 2]
22 25[0011001
23 32|
24 0]
25 5]
26 50





image16.png
, [(Caliori (Body)  |v|12 |~| | I=] i, SEm, - [H]
— 53]
pase | B| T U] Al EE verge =55/ %) > ||| 48] condliondl Giee nsert Delete romat

o1 41 g Theme Coors

CNCEEEEEEN

s Wi

Standard Colors

CLTINWETTT T
INGIE Enter ONLY in BLUE Row above a 1 to calculate that bit

Omorecoors.. |

—

Enter number
above first





image17.png
=, [(Caliori(Body) |~ |11 |~ |

we (B[1[UJ[SHAL

ey [T —

Cﬁ‘ not Enter in this row

NoFil

== g abev | =0 Wrap Text v General

verge - 18| %) > ||| 8] condlional gy

o
L]
=]

} | above first

Enter ONLY in BLUE Row above a 1 to calculate that bit

© More Colors..





image18.png
Lallblhl (body)

[

wehneral

$v% 9

Bottom Border

Top Border |

Left Border |

Right Border

No Border

All Borders

Outside Borders




image19.png
Binary No

Enter number
4 | above first

8 bit Code

Enter 1 or 0 in blue row

Do not Enter in this row

check total

Enter ONLY in BLUE Row above a 1 to calculate that bit





image20.png
Binary No

Enter number
above first

Enter 1 or 0 in blue row check total

Do not Enter in this row

Enter ONLY in BLUE Row above a 1 to calculate that bit





image21.png
Format Cells

((Namber | Aignment _Font | Border | Pattems _protection |

Category: sample

General

Currency. Decimal places:

Accounting

Date 0 Use 1000 Separator ()

Time

Percentage

Fraction Negative numbers:

i‘::'" © 123410

el 1234.10

Do (123410)
1234.10)

Number is used for general display of numbers. Currency and Accounting offer
specialized formatting for monetary value.




image22.png
Tl

e
Fe=—

Animal Sounds | Sheet2 ] Sheetd




image23.png
Format Cells

((Namber | Alignment __Font | Border __Patterns _Protection )
Category: Samele
General
Number
Currency Type
Accounting

3/14/01

Time 03/14/01
Percentage La-Mar
Fraction La-Mar-01
Scientific 1a-Mar-01
Text Mar-01
Special March-01 ¥
Custom March 14, 2001 &

Date formats display date and time serial numbers as date values. Use Time
formats to display just the time portion.




image24.png
Format Cells

((Namber | Algnment _Font | Border _parierns _rotection |

Category: Samele
General

Number

Currency Type

Accounting

Date 130M
13:30555
Percentage 130:55 PM
Fraction 30:55.7
Scientific 373055

Text 3/14/01 130 P
Special 3/14/01 13:30
Custom

“Time formats display date and time serial numbers as time values. Use Date
formats to display just the date portion.




image25.png
® Excel File Edit View Insert Format Tools Data Window Help

O EE R @ R[X% 0 RSB0 T4 k|l e o D@
| B/ UE==s % » 0

Verdana ¥) 10 ¥) paste Special..

| s v B =





image26.png




image27.png




image28.png
Mx vE=

|

123
188 a0

388 -





image29.png
X v E=

I

|=B2s83)/C3

ablaal ' il




image30.png
123
188 a0





image31.png
123
188
253
318
383
s
513
578
843
708
773
838
503
68
1033
1098





image32.png
Equal sign (i the function is t the beginning of a formula)
Function name

=SUM(A10,B5:810,50,37)

4 comma separstes each argument

Parentheses enciose arguments |





image33.png
15t Quarter 2nd Quarter | 3rd Quarter | 4th Quarter

Projected 75000 85000 2000 101000
Actual 24813 99123 102000 120000
Data markers with
the same pattern Data marker
140000
120000
100000 o et
50000 et
50000 [ Chart data
40000 Series
20000
3
;nd w4
Quarter _ Quarter _ Quarter

UAxis values Category names





image34.png
= o

| © Cotumns and rows and cell
SRR < Columns and rows and

s, that's what worksheets are made of - Training - Microsoft Office Onli

Ele Edt View Hstory Bookmarks Toos Help

Fina

cut

copy - - @

Paste

3 hitp:fjoffice. microsoft. comitraining/training, aspx?AssetID=RP10076661 10338 TT=630rigin=RP100;

Google

Repiace

< Format painter

j:
[ customie Links ] Free Hotmil

il ] windows Marketplace [ ] Windows Media | windows

seiect

DOl v
C.0ffice Online
| Home  Products | HelpandHow-to | Downloads  ClipArt  Templates  Microsoft Office Live
B ettoknombncel | Hme ~ Ho mibwto ~ T » Exlzoy
2007 Craate your
. fest workbook ,
Columns and rows and cells, that's what
o Overview
: - et mewonen | MACE OF
o ‘The Ribbon
: Workbooksand
v
i - w
B ™ - oy o e et
: Colame amd rows OHOODO D Y = et
and cell,thats what
B worksheats ore
. ade of - o
o Cells are where the data = s
e B o= ceeon o mh mE Gm
N Practice y
E i = =] | —
B @
N ® Enter data ¥ (B e
- £di data and revise
ot
- (bt ALy £
- Quick Reference Card B C D E F S H
. 2
2| 5 D
: a
= 5
. After the first 26 column headings (A through Z), the next 26 column headings are AA
& through AZ. The column headings continue through column XFD, for a total of 16,384
- columns.

i

N <

Colurnn headings are indicated by letters

Row headings are indicated by nurmbers

Aunia TEXT

Sian into My Office Online (what's this7) | Sign in

n.

—

asvartzement

Geto©

the 2007

Microsoft Office

system today.

It's anew day.
It's a new office.

Try it now. ©
Get it here.

Page:1of1 | Words:7 | < | Done

3 e

5





image35.png
Microsoft Of

fox.

Intornet DV Dscrypte | Cells are where the data goes - Traini

Ele Edt View Hstory Bookmarks Toos Help

Explarer.
Y B @« eon

CERE e[ Customiz ks ] Fres Hotmad (] Windows Marketlace ] Windows Hedia (] Windows

'3 htpyfoffice microsaft.comjtrairingftraining.asp?ssetID=RP 1007666210338 C TT=680rigin=RP 1003 | + Google

T Home > Halp and Howto > Training » Exce 2007

2007: Create your
first workbook.

Cells are where the data goes

overview
) Meet the workbook agiertement
The Ribbon

v
workbooks and (ClollolololcIEC) - Find the
. right
ok taga bt a9 o P oo |
e e o 0g) employee

Celle are where the Home | Inset  Page layout Home | Inset  Page layout in your

et oes
o B = = b area, fast!
G

e
rmern cipboard 1 Cipboard

it data and revise a =(3) -~ Post a job
0

Font
worksheets F now and
SAVE
OVER 12%

Test yoursel Paste

Feedback A

Quick Reference Card

[—

When you open a new workbook, the first cell is the active cell. It has a black outline. In the
second picture, cell C5 is selected and is the active cell. It is outlined in black.

Colurnn C is highlighted
Row s highlighted

Cell C5, the active cell, is shown in the Name Box in the upper-left comer of the

workshest monster

Aupia TEXT

Cells are where you get down to business and enter data in a worksheet





image36.png
H9 06 )* Document1 - Microsoft Word -7 x
©
090+ 100 Excel 2007- Create your first workbookl - Microsoft Excel - = x
Home | Inset  Pagelajout  Fomuas  Data  Review  View  Addins  Aaobat @- > x
= o = =, = AutoSum -
B T T =[] | Zrwmp e Genera - - J == A7 #
) = - 8] Fil -
paste B Zu- B> A terge & Center - | [ $ = % 3 |[%8 8| | Conditional Fomat Cell | Insert Delete Fomat Sort Find &
= o2& A q L B tima s Tomie- sures || = D | Qi Fner: st
Ciipboard % Font 5 Alignment = Number stes cels Ediing
AL - £ ¥
ﬂ 8 c D £ F s H l 3 3 a
2 |
3 |
4|
> |
[ 6|
¥ 4+ | Budget ~Shest2 ~Sheet3 &3
Ready
- Copy this fle B]Getting to know Excel 1,069KB  Micosoft Offce Wo... 25/01/2008 10:00 4
N & Publsh sl tothe Web || 1100 Excel 2007- reate your first workbookt 1S16KB Mirosoft Office Wo... 210312009 10:39 Al
N () Emai this e i) Getting to Know Excel 2007 997KB  Microsoft Office Wo... 28/01/2008 10:03 4
& Printhisfie 9]101 Excel 2007- Create your first workbook2 PIF KB Microsoft Office Exc...  2/03/2009 10:40 A
M X Delte this e
B Other Places 2
R 2 Bl
Q) ty Docurents
£ Shered Documents
3 1y Conputer
3 etk Places
B Details 5
N kil
Poge: S engish (US)

e





image37.png




image38.png
@ FERCER Get to know Excel 2007~ Create your first workbook. - Microsoft Excel _ax - = x
G

Home | Insert  Pagelayout  Formulas  Data  Review  View  Addlns  Acobat ©@-1° x C
e o Geem - ElCondtionst Fomating - | Sesert- | X - N
- 2R - vl el 0 ) R i S e
Fee g || B (][ A e = censtes - Bl romet || O~ paes e Heading 5 ||| COSME | ¥ etect
(Clipboard Font 5 Alignment 5| Numper & Stytes cels Editing 5| edting
AL e £ | worksheet 2 Sl s
B c D E F G H 1 J K L M N E

W4 n] practice | Sheetd ~Sheetd ¥J 0
Ready

Clickthe Sheet2tab. That moves youfrom the Practice worksheet o the Sheet2 worksheet.In  blank worksheet ts

hardtotellthatyouve really changedshests, since everything ooks the same. Thats why we put Worksheet2*in cell
A ofthis one.

Nowuse akeyboard shorteutto moveto the Sheet3tab. Press CTRL+PAGE DOWN.

Nowyoureinthe Sheets worksheet (i says “Worksheet " atthe top)

Try the keyboardshorcutto moveto the previous workshest. Press CTRL+PAGE UP. There's Worksheet2'in cell A1
Exercise 3: Add color to worksheet tabs.

Youcan add colorto worksheettabs to make them easierto ellapart.





image39.png




image40.png
AL





image41.png




image42.png
H9- ™ 100 Excel 2007- Create your first workbookl [Compatibility Mode] - Microsoft Wo... | PidureTools | - = x
= ®
@ H9-¢) 101 Excel 2007- Create your first workbook2 PJF [Compatibiity Mode] - Microsoft Excel - = x
Home | Inset  Pagelayout  Formulas  Data  Review  View  Adddns  Acrobat @ - ™ x
= = =5 | F Autosum
R o T pe— LRl L
Fi-
Fste (B oz ou-|E Condiora Fomat_Cel_ | Inset Delte Format sorta Fnds
g o= Fomating - asTome- syes= | o D PO D eare e St &
Ciipboard % Font 5 Alignment 5 Styes ceis Editing
0 gO ¥
A 8 c ) 3 £ s H K L v N ) P a H
Expenses January February March  April  May  June  July  August September October November December

Mortgage  600.00
Telephone 4525
Utities 6727
Charge Car  200.00
Electicity  100.00
Auto Insurar 150,00
Cable TV 075 1
Groceries 14000
Pets 2500
Meals Out 4000
Entertainme  20.00
AutoLoan 20000
Water 15.00

[3lanx[n /8] 8] = (x]5 0 s 5] 2[5 [e]o v fu oo ]n ]

%)=& 1047




image43.png
Getting to Know Excel 2007 (Compatibility Mode] - Microsoft Word

—— [ — -
©
\B9-c-) Get to know Excel 2007- Create your first workbook2 - Microsoft Excel - = x
) H 9
Home  Insert  Pagelayout | Formulas Review Adddns  Acrobat @ - = x
(5] JDefineName - e Trace Precedents ] Show Formulas s
ﬁiﬁﬁiﬁ@ﬁﬁﬁ i e oo | &3 e
Insert | Autc ﬁnmummlm Text Date& Llookup& Math  More fPu=o y e b erer N Caleulation
o : . » Calcwlate Sheet
o) N e % e~ Reerence - 8ng - Fundions - | Manager B Ceat from Seledion | . Remove Aows = (2 luate Fornula | Windw | Optens- 5
Fundiion Library Defined Names Formula Auditing Calawiation
Test -G f | Expenses E
=l c [ o [ e[ r[ e[ al. 7 v m [ n [ o[ e [ al cj
[Expenses Jlanuary February March  April May June  uly August  September October November December
Mortgage 600.00
[Telephone 45.25
Utiliies 67.27
Charge Carfls 200,00
(Heating Oil 100.00
[Auto Insuragce 150.00
Cable TV 40.75
(Groceries 40.00
Pets. 25.00
Meals Out 40.00 £
[Entertainmeint 20.00
[Auto Loan 200,00
wWater 15.00
RN
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To enter  datein column B, the Date column, you shoulduse a slash or a hyphento separate the parls: /1612009 o 16-July-2009. Excel
willrecognize thisas a date.
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Tip_To entertoday's date, press CTRLand the semicolon () together. Toenter the currentime, press CTRL and SHIFT and the sermiclon
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Press TAB to move the selection one cell to the right. Press ENTER to move the selection down one cell

Excel aligns text on the left side of cells, but it aligns dates on the right side of cells.
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